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INTRODUCTION 

Le formulaire TranspoLithSIG a été optimisé pour un affichage 1024x768. Si la résolution de 
votre écran est plus petite (800x600 ou 640x480), il est possible que certaines portions du 
formulaire soient hors écran. 

Le formulaire TranspoLithSIG a été conçu pour transposer aisément dans un tableau les 
données analytiques obtenues par e-sigeom à la carte. Il ne traite que les analyses de roche, 
les analyses de l’environnement secondaire étant traitées avec le formulaire TranspoSedSIG. 

Selon le format demandé dans la requête originale, les données lithochimiques reçues de 
SIGEOM se composent des éléments listés dans le Tableau 1.  

 

 
Tableau 1 – Fichiers obtenus selon le format demandé dans e-sigeom à la carte après extraction du fi-
chier compressé. 
 

NOTES 

1. TranspoLithSIG a besoin de 2 fichiers pour fonctionner : 

1) un fichier ANALYS_R.DBF (présent dans tous les formats possibles dans SIGEOM); 

2) un fichier nommé ROCHE.DBF. 

Dans les formats Microstation et Autocad, aucun ajustement n’est nécessaire.  

Dans le format Mapinfo, l’utilisateur doit d’abord importer la table ROCHE.MIF (Table⇒Importer) et en-
registrer la table ROCHE.TAB. Il doit ensuite exporter la table en format DBASE (Table⇒Exporter).  

Dans le format Arcview, il suffit de renommer le fichier ROCHE_pt.DBF pour ROCHE.DBF. 
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TranspoLithSIG exécute en arrière-plan un grand nombre de requêtes. Pour éviter une multiplicité de mes-
sages inutiles, l’usager devrait s’assurer que les cases « Modifications des enregistrements », « Suppres-
sion des documents » et « Requêtes actions » de la section « Confirmer » (Outils⇒Options) ne soient pas 
cochées (Figure 1). 

 
Figure 1 – Configuration de la section “Confirmer” dans les Options d’Access. 

 

Ces ajustements réalisés, vous êtes prêt pour passer à la première étape. 
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1 1 - Importer les fichiers  

En cliquant sur ce bouton, un message d’information apparaît signalant que le fichier 
ANALYS_R.DBF sera importé dans le formulaire. Cliquez sur « OK ». Vous retrouvez 
dans la fenêtre suivante le répertoire contenant les fichiers ANALYS_R.DBF et 
ROCHE.DBF. Ne pas oublier de préciser le format DBASE IV (*.dbf) à la ligne « Type 
de fichier ». Le fichier ANALYS_R.DBF devient alors visible. Sélectionnez-le et pressez 
sur « Importer ». Attendez la fin de l’importation puis pressez sur « Fermer ». Un se-
cond message d’information apparaît signalant que le fichier ROCHE.DBF sera ensuite 
importé dans le formulaire. Répétez les opérations précédentes pour importer le fichier 
ROCHE.DBF. Une fois l’importation terminée, passez à l’étape 2. 

2 2 - Trouver les analyses multiples 
Il est possible qu’un même échantillon soit réanalysé pour un ou plusieurs éléments en 
utilisant la même méthode d’analyse. Le formulaire TranspoLithSIG est conçu de telle 
sorte que seule l’analyse la plus récente d’un élément est livrée dans le résultat. On 
présume que la précision analytique est supérieure à celle des analyses plus ancien-
nes. Le formulaire vous permet toutefois de consulter à l’écran l’ensemble des élé-
ments réanalysés pour tous les échantillons concernés. Vous serez alors informé des 
valeurs qui ne seront pas incluses dans les résultats à l’étape 6. Cliquez sur « Fer-
mer » pour revenir au menu principal. 

3 3 - Création des tables d’analyses 
En pressant le bouton 3, le formulaire effectue une série d’opérations qui redistribue 
les informations des fichiers d’analyse en 17 tables (16 tables identifiant toutes les mé-
thodes d’analyse possibles dans SIGEOM et une table comportant les informations 
descriptives de chaque analyse). Tous les éléments majeurs et éléments traces prove-
nant du fichier source sont répartis dans ces tables en fonction de leur méthode 
d’analyse. Si le nombre d’échantillons est élevé (> 20 000), il est suggéré de com-
pacter le formulaire avant l’exécution de cette étape (Outils⇒Utilitaires de base 
de données⇒Compacter une base de données) (figure 2).  
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Figure 2 – Comment compacter une base de données. 

 

La réalisation de cette étape peut prendre quelques secondes ou plusieurs minutes se-
lon la taille du fichier original et la puissance de votre ordinateur. Le traitement terminé, 
une fenêtre apparaît vous informant que vous pouvez passer à l’étape suivante. 
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4 4 - Choix des éléments 

C’est l’étape cruciale du traitement. En cliquant sur ce bouton, quelques fenêtres 
d’information apparaissent résumant les détails ci-dessous. Une nouvelle fenêtre ayant 
plus ou moins l’aspect de celle de la figure 3 s’ouvre).. À l’exception de la table 
ROCHE (au centre), toutes les autres tables représentent une méthode d’analyse diffé-
rente (tableau 2). La largeur de chaque table a été optimisée pour l’affichage des di-
vers éléments et ne devrait pas être modifiée. La hauteur des tables peut toutefois 
être modifiée pour assurer une meilleure visibilité. Certaines tables ont occasionnelle-
ment trop d’éléments pour pouvoir tous les afficher dans la portion visible de la table; le 
curseur à la droite de la table permet d’y accéder.  
 

 
Figure 3 – Interface de sélection des éléments. 
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Code Méthode d’analyse 
AA Absorption atomique 
AG Analyse gravimétrique 
AN Activation neutronique 
CG Analyse chimique classique 
CO Colorimétrie 
ES Electrode sélectif 
FL Fluorimétrie 
FX Fluorescence «X» 
ICP Spectrométrie de masse à couplage inductif 
IF Infrarouge 
IR Infrarouge, absorption, émission 
PL Emission de plasma 
PY Pyroanalyse 
SM Spectrométrie de masse 
SX Spectrométrie à rayon X 
YO Inconnu 

Tableau 2 – Codes d’identifications des tables et méthodes 
d’analyse correspondantes. 

 

Cette interface est relativement simple d’utilisation. Double-cliquez successivement 
avec le curseur l’élément que vous désirez retrouver dans le tableau de sortie; cet 
élément sera automatiquement inséré sur la ligne « Champ » de la grille Access au 
bas de la fenêtre (voir animation ci-dessous). Cliquez sur « Fermer » pour revenir au 
menu principal. 

 

demo_selection.swf  
NOTES 
 

• Le même élément peut être sélectionné dans plusieurs tables; Access préfixera automatiquement le 
code de la méthode analytique avec l’élément dans le tableau de sortie (figure 4).  

• Le premier champ de la grille devrait toujours se présenter tel que dans la figure 3 avec 
l’expression ROCHE.*. Si ce champ était effacé par erreur, il suffit de pointer sur l’astérisque au haut de 
la table ROCHE et de transporter (drag) l’astérisque (en maintenant pressée la touche gauche de la sou-
ris) dans la première colonne, même si un élément s’y trouve déjà. L’élément sera déplacé dans la co-
lonne à droite. Les données de la table ROCHE seront ainsi sauvegardées dans le tableau de sortie. 
Certains paramètres de cette table (nordant et estant, zone de projection UTM, code lithologique, source 
de donnée, etc.) seront très utiles dans la création éventuelle d’un fichier de points dans Mapinfo ou Arc-
view. 

• Peu importe la nature des éléments demandés, la requête produira autant de lignes qu’il y a 
d’échantillons dans le fichier original1. Les lignes des échantillons qui ne possèdent pas d’analyses 
pour les éléments demandés seront vides (figure 4). Une solution pour éliminer ces lignes est proposée 
dans la section 7. 

                                                 
1 Ceci est dû au type de lien entre les tables dans Access. 
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• Les valeurs analytiques sous le seuil de détection et décrites comme « inférieur à » (<) dans le fi-
chier original ont été réécrites à –999 dans le tableau en sortie. 

• Access ne prend pas plus de 256 variables dans une requête. Si vous désirez demander plus de va-
riables, il suffit de recommencer l’opération à l’étape 4 après avoir complété la sauvegarde et 
l’exportation des résultats (étapes 5 et 6). 

• Si vous désirez tous les éléments d’une table, double-cliquez sur l’astérisque dans le haut de la 
table; les éléments seront tous automatiquement incorporés dans le résultat (à condition de ne pas dé-
passer 256 variables). 

 

 
Figure 4 – Extrait du tableau de sortie de la requête effectuée à la figure 2. 
Notez qu’Access a automatiquement ajouté en préfixe la méthode d’analyse si 
le même élément a été sélectionné dans plusieurs tables. Les lignes vides 
signifient que les échantillons n’ont pas été analysés pour les éléments 
demandés selon les méthodes choisies. 

 
Une fois vos choix terminés, cliquez sur « Fermer » pour revenir au menu principal. Votre 
sélection est automatiquement sauvegardée. Passez à l’étape 5. 
 

5 5 - Sauvegarder le résultat 
 
Cliquez sur le bouton 5. Un premier message vous demande de confirmer la suppression de 
la table de résultats des requêtes antérieures; répondez Oui. La création de la nouvelle table 
terminée, une fenêtre s’affiche pour présenter les résultats qui seront exportés en tableau de 
sortie. Si le résultat n’est pas satisfaisant, recommencez l’étape 4. Si tout est correct, cliquez 
sur« Fermer » pour revenir au menu principal. Passez à l’étape 6.  
 

6 6 - Exporter le fichier 
 
En cliquant le bouton 6, une nouvelle fenêtre d’option d’enregistrement s’ouvre (figure 5). 
Conservez l’option “Vers un fichier ou une base de données externe” cochée. Cliquez 
sur « OK ». Sélectionnez le répertoire où vous désirez sauvegarder les résultats. Modifiez le 
nom de fichier (pas obligatoire, mais recommandé) et sélectionnez dans le menu déroulant 

Commentaire : Vérifier avec 
l’auteur si ce commentaire est bien 
placé. 
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en-dessous le format d’exportation de votre fichier. Le format Excel est recommandé. Fermez 
le formulaire en cliquant sur le bouton rouge du coin supérieur droit. 
 

 
Figure 5 – Fenêtre d’enregistrement des résultats. 

 

7-Procédure suggérée pour éliminer des échantillons sans résultat analytique  
 
Pour éliminer du tableau obtenu les lignes dont les champs analytiques sont vides pour les 
variables demandées, nous vous suggérons de procéder comme suit. 
 

1. Ouvrez le fichier dans Excel et sélectionnez l’ensemble du tableau en cliquant sur la 
case du coin supérieur gauche (figure 6). Pour améliorer la visibilité des résultats, 
ajustez automatiquement la largeur des colonnes (Format⇒Colonne⇒Ajustement 
automatique) (figure 7). 

 

 
Figure 6 – Sélection du tableau complet. 
 

 

Commentaire : À mettre dans 
le même format que les autres 
titres. 
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Figure 7 – Ajustement automatique des largeurs de colonnes. 

 
2. Appliquez un filtre automatique au tableau (Données⇒Filtre⇒Filtre automatique) (fi-

gure 8). Les variables analytiques apparaîtront maintenant comme à la figure 9. 
 

 
Figure 8 – Création d’un filtre automatique. 

 

 
Figure 9 – Variables analytiques en filtre automatique. 
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3. Sélectionnez dans le menu déroulant maintenant accessible, à la droite de chaque en-

tête de variable, l’option (Vides) qui se trouve au bas du menu (figure 10). Répétez 
l’opération pour toutes les variables. Les triangles pointant vers le bas à côté de 
l’entête des variables devraient tous être bleu à la fin de l’opération. 

 

 
Figure 10 – Sélection de l’option (Vides) dans le menu déroulant du filtre automatique pour chaque 
variable. 

 
Les lignes visibles maintenant à l’écran sont toutes vides de données analytiques. Il est pos-
sible de lire dans le coin inférieur gauche de la fenêtre combien de lignes vides sont affi-
chées. Pour supprimer ces lignes, pointez la cellule A2 (figure 11) de la feuille et pressez les 
touches « Ctrl-Shift-End », ce qui saisira l’ensemble des cellules à supprimer. Supprimez les 
lignes avec Édition⇒Supprimer la ligne (figure 12). L’opération terminée, enlevez le filtre au-
tomatique Données⇒Filtre⇒Filtre automatique. Votre fichier Excel est maintenant prêt à être 
utilisé. 
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Figure 11 – Sélection de la cellule A2. 

 

 
Figure 12 – Supprimer 
les lignes vides. 

 


